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Introduction

Introduction

Welcome to the Bridgemate Pro scoring system. Bridgemate Pro is an advanced electronic scoring
system for bridge clubs and tournaments, designed to enhance the enjoyment of bridge. Bridgemate
Pro automatically registers board results. The scores are verified and fed to the central PC.
Tournament directors will value the user-friendly features of Bridgemate Pro, as it enables them to
focus fully on their core tasks.

This manual describes the operation of the Bridgemate Pro scoring system, including the central
software program, the server and the Bridgemate Pro scoring systems. This manual serves as an
addition to the manual supplied with your scoring program. As the Bridgemate Pro scoring system
operates independently from the scoring program, this manual does not include instructions for
operating your scoring program.

This manual consists of the following chapters:

- The components of the Bridgemate Pro scoring system are explained in Chapter 1. A brief
and concise explanation is given of the individual components and how they relate to each
other.

- Chapter 2 explains how to configure and install the Bridgemate Pro software and hardware
and how to configure the Bridgemates per section and table. This chapter also explains how
to set the radio channels to enable wireless data exchange.

- Chapter 3 explores the use of the Bridgemate Pro Control software program in more detail.

- Chapter 4 explains the different BPC options offered by the Bridgemate Pro server.

- Use of the Bridgemate Pro scoring devices is explained in Chapter 5.

- Chapter 6 highlights the additional functions of the Bridgemate.

- Chapter 7 contains tips on how to operate the Bridgemate Pro scoring system when multiple
bridge clubs are playing simultaneously in one room. Practical advice is also offered on how

to deploy Bridgemate Pro in big tournaments, involving different rooms and/or multiple
servers.

Version numbers
This manual covers the following versions of the Bridgemate Pro components:
Bridgemate Pro Control 1.2

Bridgemate Pro server 1.1 (firmware version)
Bridgemate Pro scoring devices 2.0 (firmware version)
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Chapter 1. Description Bridgemate Pro scoring
system

This chapter describes the components of the Bridgemate Pro scoring system and how they relate to
each other. It also explains how to use the Bridgemate Pro: from creating a session in your scoring
program to registering the scores in the scoring program.

Please read this chapter carefully. Once you understand the function of the individual components and
how they relate to each other, you will quickly get to grips with the Bridgemate Pro scoring system.

Description of components

In order to make full use of the Bridgemate Pro scoring system, the following components are
required:

Bridgemate Pro score input devices

Bridgemate Pro server

Bridgemate Pro Control software

Client (= PC with Bridgemate Pro Control software)
Result file

Scoring program

Bridgemate Pro score input devices

The Bridgemate Pro score input devices are placed on the bridge table and are used to enter the
scores. For the purpose of simplicity, we shall refer to these input devices as "Bridgemates”. Wireless
communication between the Bridgemates and the server is established and maintained using radio
frequency waves. Only one Bridgemate is required per table. The use of the Bridgemates is explained
in more detail in Chapter 5.

Bridgemate Pro server

The Bridgemate Pro server, “server” for short, is a small device connected to the PC. It acts as a
bridge between the PC and the Bridgemates. As the PC cannot communicate directly with the
Bridgemates, the server is a vital component. The server is equipped with a transmitter and a receiver,
establishing and maintaining wireless data communication with the Bridgemates. The server sends all
movement data to the Bridgemates, including board numbers and pair numbers, and receives the
board results in return. The server can control up to 128 Bridgemates simultaneously.

Bridgemate Pro Control software

A specific program is required to control the server from the PC: Bridgemate Pro Control (“BPC”). This
program runs on Windows95 or higher and is controlled in part by your scoring program. BPC fully
controls the server and data exchange between the server and the PC. BPC first saves all the relevant
session data used by the server to control the Bridgemates. BPC then retrieves all entered board
results from the server and stores these in the result file. All other server controls are also executed
from BPC.

Client

The Bridgemate Pro Control program runs on a so-called “client” PC. The scoring program and BPC
usually run on one client, to which the server is also connected. During big tournaments, multiple
servers may be required to support the high number of Bridgemates and/or to establish and maintain
the wireless communication between the server and the Bridgemates. In this case, the servers are
connected to a network PC, and the network consists of multiple clients.
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N.B. The term “client” suggests that the Bridgemate Pro scoring system also consists of a PC network
server. This is not the case. All (network) PCs running the Bridgemate Pro scoring systems are known
as clients.

Result file

The result file is created by the scoring program and/or Bridgemate Pro Control. It contains all the
session data, including sections, tables, movements, etc. This data is generated by the session
configured in the scoring program. BPC can now feed the correct data to the server. BPC reads all the
board results entered in the server and saves these in the result file. All Bridgemate Pro result files
have the file extension .bws.

Scoring program

The scoring program creates the session and calculates the scores. After you have created a session,
the scoring program will create the abovementioned result file. This file contains all the relevant
session data. The scoring program will read all board results saved in the result file and process these
in the session. These procedures are explained in more detail in the user manuals or help files of your
scoring program.

Procedure

Having examined the individual components of the Bridgemate Pro scoring system, the next step
involves assessing the entire process and how the different components relate to each other.

The process is outlined in the below diagram:

Activity Explanation

This is the starting point in the process. In the session, users can set
the number of sections to be played, the number of pairs per section,
games and movements.

Step 1: Session created in the
scoring program.

Using the session data, the scoring program creates a result file,
containing all data relating to the sections, corresponding movements,
games and pairs.

Step 2: Result file created in the
scoring program

Step 3: Bridgemate Pro Control The result file is read in BPC, generating the data of all tables used in
reads the result file each session.

BPC initializes the server using the data contained in the result file. All
Step 4: Bridgemate Pro Control session tables are stored in the server. Movements from each table are
transfers data to the server. included, so that the server knows (per round) which pairs and games
correspond with which table.

Step 5: The server has been Now that all the relevant data has been stored in the server, the
activated and the Bridgemates can Bridgemates can be activated. The players activate the Bridgemates,
be activated which log in to the server. The scores can now be entered.

During this process, the board number and pair number/direction of play
are verified for accuracy. Verification is executed via direct
Step 6: Scores are entered in the communication between the Bridgemate and the server. The
Bridgemate and sent to the server Bridgemate itself does not contain any movement data. Entered board
results are sent direct to the server. This data is stored in the server
memory.
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Step 7: Bridgemate Pro Control

retrieves the scores from the server. BPC reads all newly entered scores from the server and saves them in
The scores are saved in the result the result file.

file

Step 8: The scoring program reads The scoring program reads the scores saved in the result file and stores
the scores saved in the result file these in the session. The scores are processed and incorporated in the
and adds these to the session session to calculate the final score.

Automatic launch from your scoring program

If your scoring program fully supports Bridgemate, Bridgemate Pro Control can execute steps 2 to 4
and read the scores (step 7) automatically via one simple command. For further information on how to
enable automatic launch of the Bridgemate Pro scoring system, please contact the supplier of your
scoring program.
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Chapter 2: Hardware configuration

System requirements

Operating system

The Bridgemate Pro scoring system can run on Windows 95 or higher.

Hardware

Recommended configuration:

Processor Pentium Il 300MHz or higher
Memory 64MB or higher

The PC must also be equipped with a serial port. If your PC does not have a serial port, please use a
USB - serial converter to connect an extra serial port to the PC. This converter is available from your
Bridgemate supplier.

Installing Software

To install the Bridgemate Pro scoring system, you will need to run the “BMProSetup.exe” file. This
software is supplied on CD Rom. The requirements for the installation of the Bridgemate Pro software
may differ, depending on your scoring program. For more information about where to install the
software on your PC, please consult the information supplied with your scoring program. To install
Bridgemate Pro on a separate client, we recommend the default folder (=C:\Program files\Bridgemate
Pro).

Installing the server

Power supply

To operate the server, please ensure it is connected to a mains power source or is fitted with batteries.
The server cannot operate without a mains power source and batteries. Any unsaved data in the
server will be lost.

Mains power

A 9V adapter is supplied with the server. Plug the adapter into the wall socket and the plug in the
black connection at the top of the server. The green LED on the server will light up, indicating that the
server is now connected to the mains.

Batteries

Batteries are used if there is no mains power source, or as a back-up in the event of power failure.
The battery compartment on the bottom of the server holds four AA 1.5 volt batteries (not included).
Install the four batteries as indicated. A red LED will light up, indicating that the batteries have been
installed correctly and no mains adapter is used. The approx. operation time of the batteries is 50
hours.

If both the mains adapter and batteries are used, the server will obtain its power from the adapter. The
batteries will only be activated if the adapter is not supplying power (e.g. during a power cut). Power
will immediately transfer to the batteries and no data will be lost. We recommend installing batteries
while the server is in operation as a back-up. This will ensure no data is lost during the session.
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Switching on / off

The server will automatically switch on once the mains adapter is connected or the batteries are fitted.
To switch off the server, both power sources will need to be removed. It is recommended to remove
the mains adapter and batteries after you have finished using the server. Only one of the four batteries
needs to be removed. To remove the batteries, please use a screwdriver or pen. Please do not
attempt to remove them with your fingers.

Connecting the server to the PC

Connect the server to the serial port of your PC. If your PC does not have a (second) serial port,
please use a USB-> Serial converter which is connected to the USB port. This allows you to add an
extra serial port to your PC. Converters are available at your local Bridgemate distributor. It comes
with a set of software drivers which need to be installed seperately. See the included documentation
for more installation of these drivers.

When using a converter, please ensure the serial port has a port number between 1 and 6. If the
assigned COM port is 7 or higher, it will need to be corrected manually in Device Settings of Windows
Control Panel.

Configuring the Bridgemates

Before the Bridgemates can be used in the session, the section and table for each Bridgemate will
need to be configured. For more information on how to configure the Bridgemates, please see Chapter
5.

Setting the channels

The Bridgemate Pro scoring system can communicate over three radio channels. This enables users
to install multiple systems next to each other without causing interference (see also Chapter 6,
“Multiple clubs”). To enable a Bridgemate to communicate with the server, both must be set to the
same channel. You can choose between channel 0, 1 and 2. The default setting for the Bridgemate
and server channel is channel 0.

Setting Bridgemate channel
The channel over which the Bridgemate communicates is set using the same menu used for changing
the section/table settings.

SECTION: A O +/-
TABLE: 1

The “0” behind section letter A indicates the channel to which the Bridgemate is set. To switch
channels, press key 0, 1 or 2. Next, press OK twice to save the new settings.

Setting server channel

The channel over which the server communicates is set via Bridgemate Pro Control, Server >
Channel selection menu. For more information on how to set the channels, please see Chapter 4.

Operating instructions

The Bridgemate Pro server is very easy to use. Only a few instructions need to be followed. The
following rules must be observed:

- The supplied mains adapter may only be used with the Bridgemate Pro server. Under no
circumstances should another adapter be used.
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- Under no circumstances should the mains adapter be connected to the data port of the
Bridgemate (black connector at the back). This data port may only be used with the
Bridgemate communication cable and tournament director’s key.

- Under no circumstances should the Bridgemate communication cable and match plug be
connected to the mains connection of the server.

- During use, make sure the server is placed horizontally on a level surface.

- Do not place any objects on the server and make sure there is as much distance between the
server and other objects as possible. The fewer objects there are between the Bridgemates
and the server, the better the data exchange will be.

- Where possible, make sure the Bridgemates and the server are not separated by a wall. The
server should preferably be placed in a central location between the Bridgemates. If this is not
possible, place the server as closely as possible to the Bridgemates along the edge of the
playing room.
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Chapter 3: Bridgemate Pro Control software

The Bridgemate Pro Control program is the bridge between the result file and the server. BPC stores
the data from the result file in the server so that the server can control the Bridgemates. At the other
end, BPC retrieves the entered board results from the server and stores these in the result file. The
Bridgemate Pro Control program has been designed for simplicity and ease of use and is very user
friendly.

Launching Bridgemate Pro Control

Bridgemate Pro Control is launched from your scoring program. Depending on your scoring program,
there are several ways to launch BPC. The majority of scoring programs have a launching function,
enabling fully automatic activation of the Bridgemate Pro server and score reading. The scoring
program generally also contains a function to launch BPC using the existing and active result file. For
more information, please consult the manual of your scoring program.

The BPC screen is displayed as follows:

'E' Bridgemate® Pro Control - C:\Program Files'Bridge-1t, Bwsdata'c59.bws i | Dlﬂ
File Session Setrver Tools Help
e |85
Server information | alue | 1D | Section | Table | Found | Board | Pair M5 | Pair E'w | Declarerl N5 /EW | Enntractl Result | Fiemarks | Time lag
Bridgemate RF server Connected
Serial port 1
Hardware version 11
Firmware version 1.0
Communication version 1.0
Battery level AL adaptor
Channel 0
£ Alltables | Client 1sbies |
Sectmnl Table I Clignt | Status
) 1 GATEWAY
A 2 GATEWAY L 4
A 3 GATEWAY 4
[ 4 GATEWAY L 4
A 5 GATEWAY 4
& g GATEWAY 4
A 7 GATEWAY 4
B1 GATEWAY 4
B 2 GATEWAY L 4
B 3 GATEWAY 4
B 4 GATEWAY L 4
B 5 GATEWAY 4
B g GATEWAY 4
B 7 GATEWAY 4
BB GATEWAY L
Fiter |
INone 'l Apply filker |
INUne 'l Feset filter |
INone 'l
INone 'l
| Client: GATEWAY | Status: idle

The name of the active result file is displayed in the title bar. If no result files are open, the text “No
session active” will be displayed.

Server information

The pane in the top left-hand corner of the screen displays information relating to the server. If a
server has been found, the text “connected” and the version number will be displayed. You can also
check the serial port to which the server is connected, and whether server is running on a mains
adapter or batteries. If the mains adapter is used, the text “AC adapter” will be displayed; if batteries
are used, the power meter will display the number of operating hours remaining in percentages. If you



Chapter 3: Bridgemate Pro Control software 12

are using batteries, we would recommend replacing them in time rather than overusing them. BPC will
indicate when to replace the batteries. Lastly, BPC will display the channel over which the server is
communicating.

Tables

The bottom left-hand corner of the screen contains two tabs, All tables and Client tables. Below these
tabs is a list of tables. The All tables tab contains all the tables stored in the result file. These are
generally all the tables used in the session. The tables must be assigned to a client. The Client tables
tab displays the tables assigned to the client PC you are currently using. The name of this client is
displayed in the bottom left-hand corner of the screen. If you are using one PC for your sessions, all
tables will be assigned to the same client. In this case, the All tables and Client tables tabs contain the
same tables. If you are using multiple clients (e.g. in big tournaments), the All tables tab contains all
tables in the session; the tables are assigned to two clients. The Client tables tab only displays (on
both PCs) those tables assigned to that specific client.

The scoring program will create the result file for you. It is assumed that only one client is used. The
program will automatically assign all tables to the PC you are currently using. You do not need to
perform any manual changes. Manual changes are only required during big tournaments involving the
use of multiple clients and servers.

Received board results

All board results read from the server are displayed in the right-hand corner of the screen. Per board
result, users can see the table(s) to which this score relates, the players, the player declaring the
game, the overall score and the time this score was logged in BPC. Please note: the time/date
registration logs the exact time the board results were saved in the result file. If there is a server delay
in reading the scores, the system logs the time/date when the server was read and the board result
was saved in the result file. In other words, the system does not log the time/date when the score was
actually registered in the server.

Filtering board results

The filtering functions, based on one or multiple criteria, are displayed in the bottom right-hand corner
of the screen. This enables users to perform a fast search for specific scores or to compare scores.
Filter options are available per section, table, round and board number.

Creating, opening and closing result files

The result file is the starting point in the process. If no result files are opened in the program, your
options are limited. The Session menu is inactive and no scores can be processed from the server.
During normal use of the Bridgemate Pro, your scoring program will create and automatically read the
result file in BPC. You do not need to open the result file or read the relevant session data. This is
processed automatically. To read other result files in BPC, use the Open and Close functions in the
File menu.

Opening existing result file

Use the File > Open menu to open an existing result file. If this result file has not been opened
previously on this client, BPC will ask whether the client wants to log in to this result file. This step is
necessary to add tables to the client and interact with the result file.

Closing the result file

Select File > Close to close the active result file. You can now open another result file.
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Adding aclient to the result file

The score file keeps track of which clients are using the result file. Your scoring program will
automatically add your client to the result file.

If the result file has not previously been opened by a client (it has been opened on another PC), this
client has not yet logged in to the score file and cannot be used. To add a new client to the result file,
open the result file on the relevant client. BPC will ask you to confirm whether the client needs to be
logged in to the result file. Confirm. You will now be able to start using the result file.

Managing tables

Assigning tables to a client

Once a result file has been opened, all tables of the result file will be displayed under the All tables
tab. The “Client” column will display the text “not assigned” if the scoring programme has not assigned
the table to the current client (this only occurs sporadically) or if the table has been removed by a
client. To assign a table to the client you are currently using, right-click on the table and select Add to
client. To add multiple tables simultaneously, select the table by clicking and holding the left mouse
button and the Shift key, or use the Select all function to select all the tables. Once the table has been
added to the client, the client name will be stored in the table. You can only assign tables to the client
(PC) you are currently using. If you are using multiple clients in a network, the result file will need to be
opened manually per client and the tables added to the relevant client.

Taking over tables from another client

To transfer a table that has already been assigned to another client to your own client, repeat the
above procedure. Right-click on the table and select Add to client. BPC will ask you to confirm whether
you would like to take over the table from another client.

Overview of tables assigned to a client
The client to which the tables have been assigned is displayed in the “Client” column of the All tables
tab. The Client tables tab only displays those tables assigned to the current client.

Removing tables from the client

Click on the Client tables tab for an overview of all the tables added to this client. Right-click on the
table you would like to remove and select Remove from client. The table will now be removed from the
client.

Server control

Activating the server

To activate the server, connect it to the client PC and connect the mains adapter or fit batteries. Once
the server has been found, specific data will be displayed in the top left-hand corner of the screen and
the Server menu will be activated. You are advised to connect the server before launching BPC.

Resetting the server

The server contains no data when initially connected to a mains power source. New tables can be
added instantly.

If the server contains data which you would like to delete, you will need to empty the server. This is
done using the reset function. Go to Server - Reset. You will be asked to enter a verification number.
This verification number ensures that the server cannot accidentally be reset. Once the correct
verification number has been entered, the server is emptied and all data removed.
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Adding tables

The server is activated by adding tables. As soon as a table has been added, the server feeds this
data to the corresponding Bridgemate, which in turn is activated. The Bridgemate cannot operate if the
corresponding table has not been added to the server. Tables can only be added once to the server. If
you attempt to add a table that has already been added to the server, an error message will be
displayed.

To add a table to the server, go to the Client tables tab, select the relevant tables, right-click on one of
the tables and select Add to server. The tables will now be added one by one to the server, and the
corresponding movement loaded per table. An overview of the added tables will be displayed.

Removing tables

It is also possible to remove tables from the server using the Client tables tab. Select the tables you
would like to remove, right-click on these tables and select Remove from server. The tables will now
be removed. You will not be able to use any Bridgemates that are configured to these tables.

Synchronizing the server and client

All data relating to the tables is saved separately in both the result file and the server. This avoids
discrepancies between the two in the event of a temporary disconnection between the server and the
PC. These discrepancies can be rectified using the Session - Synchronize client <-> server menu
function.

synchronize table entries for server <-= client

— Synchronize options

¥ Delete tables from server which are nat in session

Tablesz in server which are nat in client:
™ Delete from server
& Add to client

W Take over from ather client

Tables in client which are not in gerver:
 Add to server
¥ Dielete from client

™ Delete from session

Wearning: movement data will not be updated. Use "Update
mavement’’ to renew maovement data of server.

Check the relevant options to indicate your synchronization preferences. You are effectively
determining whether to synchronize the server to the result file, or whether to update the result file
using the data stored in the server.

Tables in server which are not in client

Use this option to determine what to do with tables stored in the server but not assigned to the client.
To delete these tables from the server, select “Delete from server”. To add them to the client, select
“Add to client”. Tables that have already been assigned to another client can only be assigned to the
current client if the “Take over from other client” option has been checked. If this box has not been
checked, the tables cannot be added to the client.

Tables in client which are not in server

Conversely, some tables may have been assigned to the client but not to the server. To add these
tables to the server, select the option “Add to server”. To delete these tables from the client, select the
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option “Delete from client”. This option also allows you to delete all the tables from the result file by
checking the “Delete from session” option.

Delete tables from server which are not in session

The synchronization function will also verify whether the server contains tables not contained in the
result file. These are so-called “obsolete tables”. Check the “Delete tables from server which are not in
session” option to delete these tables from the server. If this option is unchecked, these tables will not
be removed.

Synchronizing client to server and vice versa

As outlined above, the main function of the synchronization process is to synchronize the client to the
server and vice versa. The default settings of this function are configured to synchronize the client to
the server: tables that have been assigned to the server but not to the client and tables that have been
assigned to the client but not to the server are removed from the client.

These settings will need to be adjusted when synchronizing the server to the client. In this case, delete
all tables from the server that have been assigned to the server but not to the client (select “Delete
from server”). Conversely, add to the server all tables that have been assigned to the client but not to
the server (select “Add to server”).

In all these cases, make sure the “Delete tables from server which are not in session” option is
checked to delete all tables that have been assigned to the server but not the result file (and therefore
not to the session). Should it transpire that these tables were correctly stored in the server and not in
the result file, a new result file will need to be created, or the current file updated.

Updating movement in the server

Movement data is assigned to all tables added to the server during the synchronization process. The
synchronization function does not update the movement data of tables already stored in the server
and which have not been updated. If the movement data of the result file has been synchronized from
the scoring program, use the Session > Update movement menu function to update the server with
the correct movement for these tables.

Update movemenk : x|

— Select sections

Section & ﬂl

[+ Do not update round 1

Update now I

All sections are checked by default. All table scores belonging to sections that you wish to update will
now be deleted. Uncheck all sections that you do not wish to update. Round 1 is not updated by
default, i.e. scores that have already been entered are retained. To update round 1, uncheck the “Do
not update round 1” option. Press Update now to update the sections with the correct movement. A
report will be displayed of the executed operations.
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Logging in and logging off Bridgemates
Logging in Bridgemate

Once the corresponding tables have been added to the server, the Bridgemate Pro scoring devices
can be activated. If this is not the case, the Bridgemate cannot be activated.

Once the Bridgemate has been activated, the start-up screen will display the text “Bridgemate Pro”
followed by the version number. Press OK to go to the section and table number screen. Press OK
again to log the Bridgemate in to the server. The flashing symbol in the top right-hand corner of the
screen indicates that radio communication is taking place. Once the Bridgemate has logged in, all first
round data will be displayed. The Bridgemate has now been activated. The red symbol in the “Status”
column of the All tables and Client tables tab will turn to green (provided the function “Retrieve data
from server” is checked, see Board results — Reading from server later on in this manual). This column
also gives a clear overview of all inactive Bridgemates: if the status column is still red, the table has
not activated the Bridgemate.

In the following cases, the Bridgemate will not be logged in to the server, but returned to the start-up
screen:

- The corresponding table has not been added to the server.

- The session of this table has finished, all the scores have been registered for this table. In this
case, the Bridgemate will display the message “End of session”.

- Another Bridgemate with the same section/table number setting has already logged in to the
server. It is not possible for two Bridgemates to log in with the same section/table number.

- The server is outside the range of the Bridgemate and cannot communicate with the
Bridgemate.

- The server and the Bridgemate are not communicating over the same channel.

Logging off Bridgemate

The “End session” message will be displayed for all Bridgemates that have completed the rounds and
sent all the scores. These Bridgemates are returned to the “Bridgemate Pro” start-up screen and are
automatically logged off from the server. The status column of this table will turn red again, indicating
that the session has been completed on this table. A clear overview is given of all the active tables. All
Bridgemates with green tables are still in use.

As well as logging off automatically at the end of the session, users are given two alternative options
for logging off manually:

- Using the reset function in the TD menu (option 0). The Bridgemate is returned to the start-up
screen and is logged off from the server.
- Viamenu Server > Show tables, Log off table(s). See chapter 4 for more information.

The latter function can be used if you need to use another Bridgemate for a specific reason but cannot
log off via the normal procedure. You will need to log off manually to log on another Bridgemate.

Board results

Reading from the server

Once the Bridgemates have logged in, they will feed scores to the server during the session. These
scores are first saved in the server. To save them in the result file, BPC will continuously need to read
the new scores from the server. This process can be started and cancelled at any moment. Go to

Session > Retrieve data from server, or press the F4 function key, or click on the Q‘ icon. The status
bar will display the following message: “Status: retrieving data from server”. New data is retrieved
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every second from the server and automatically stored in the result file. Information is also provided on
how to log in and log off Bridgemates from the server.

The process can be cancelled using the abovementioned menu, function key or icon. The status bar
will now display the following text: “Status: idle”, indicating that no new data can be retrieved from the
server.

If the reading process is re-activated after an idle period, all scores not yet sent to BPC will be
retrieved from the server, read and saved in the result file. Delayed reading and processing of scores
is therefore possible.

Viewing and filtering scores

Viewing scores

Scores that have been read and saved in the result file are displayed in the right-hand table of
Bridgemate Pro Control. Per score, an overview is given of the corresponding table, the round, the
players, the player declaring the game and the contract. The registration time and date is also
displayed in the result file. Remarks are also displayed (“Wrong direction” = the pair number and the
entered direction of play do not correspond with the movement, “Not played” = the Bridgemate
indicates that the game has not been played, “Arbitral score” = an arbitral message has been entered
in the Bridgemate). Only those scores retrieved from tables assigned to the client you are currently
using will be displayed.

Go to the menu Tools > Show/hide columns to select the columns you would like to hide.

Applying filter

As more board results are added and displayed, the more time-consuming and difficult it becomes to
find or compare specific scores. Although you will generally use your scoring program for this purpose,
it is conceivable that you may wish to view the registered data in BPC.

To display a specific group of board results, you can apply a filter to the entire list. This filter can be
configured at the bottom of the screen. Enter specific criteria per section, table, round and board
number. It is also possible to enter multiple criteria, for example section A, table 1, round 3. Per
criterion, enter your filtering preference - equal to, not equal, equal or less, equal or greater, between -
and enter the relevant values. Select Apply filter to apply the filter. To remove the filter and display all
board results, press Reset filter.

Changing and deleting scores

You have the option of changing or deleting results saved in the result file and displayed in the result
list.

Changing scores

Right-click on the score you would like to change and select Edit score. A detail screen will appear
displaying all the score data. You can now edit the score using the following notation: NS/N/S to
indicate the North-South direction of play, EW/E/W for East-West direction of play; clubs = C,
diamonds = D, hearts = H, Spades = S, no trumps = NT, double = x, redouble =xx, pas = PASS. Enter
a space between the value of the contract, the contract type and double/redouble. Enter a = symbol in
front of contracts that have been exactly made.

To change the board result, all you need to do is update the score in the result file. You do not need to
update the server. The server contains a copy of all scores and feeds these to the Bridgemates during
the retrieval process.

If the board result has already been read by the scoring program, it makes little sense to change the
board result in BPC. It would be better in this instance to change it directly in the scoring program. If
however the score has not yet been read, it does make sense to perform this change in BPC. The
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edited score will be displayed in your scoring program. It is however also possible to process the score
first before performing the desired changes in the scoring program.

Deleting scores

To delete a board result, right-click on the score you would like to delete and select Delete score. To
delete multiple scores simultaneously, press and hold the left mouse button and the Shift key to select
the scores you would like to delete. Deleted scores will also be deleted from the scoring program (if it
supports this function), even if the score has already been read. The score will however not be deleted
from the server. To do this, select Option 3 from the TD menu of the relevant Bridgemate.

Processing scores in the scoring program

For information on how to read and process scores from the Bridgemate Pro result file, please consult
the manual supplied with your scoring program.
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Chapter 4. Server functions

Once the server is connected to the PC, the BPC Server menu is active. This menu contains several
useful server functions. It is not necessary to open a result file to use these functions.

Overview of tables
Use the Server > Show tables menu to create an overview of the tables stored in the server.

Show tables in server |

Tatal number of tables in zerver: 15

Section | Table | Statug | Lelete tablelz) |
1
Log off table(z] |

Moo OOOOEFDEFF I
0020200000000

Cloze |

Per table, the green or red status light indicates whether this table has logged in to the server, logged
off, or has not yet logged in.

To delete a table from the server, select the relevant table(s) and choose “Delete table(s)”. The tables
will be deleted from the server, as will all the registered scores of these tables.

To log off a table manually, select the relevant table(s) and press “Log off table(s)”.

Press the “Show scores” button to create an overview of the scores entered by the Bridgemate. Select
the table(s) of which you would like to see the board results and select this function.

Overview of entered scores

The Server > Show all scores menu function displays an overview of all board results entered in the
server. Depending on the number of tables stored in the server, there may be a delay in reading and
displaying the data.

Restarting Bridgemate network

The wireless network can be restarted from the server using the function Server > Force restart. Use
this function to solve wireless communication problems between multiple Bridgemates and the server.
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Resetting the server

The Reset server menu function resets the entire server and deletes all entered data. To avoid
accidental resets, you will be asked to enter a verification number.

N.B. If the server is not connected to a mains power source and/or is not fitted with batteries, all data

will be lost. It is therefore not necessary to reset the server before disconnecting it from the mains
power source or after connecting it to the power source.

Setting the channel

The server and the Bridgemates must be set to the same channel to communicate with each other. To
set the channel on the server, use the Server > Channel selection menu.

Select server channel

Current channel: 0
Mew channel: IM 'I
Set

The “Current channel” function displays the current channel. Select the new channel and press “Set”.
The new channel has now been set.

System functions

Update firmware

The server’s firmware can be updated via the function Server - Update firmware .

Warning

This function may only be used on the instructions of your supplier. Incorrect use may result in your
server not operating properly. Only use those files supplied by your supplier and follow the instructions
carefully. We strongly advise against any other use.

Trace & debug

This function is not covered by this manual.
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Chapter 5: Use of the Bridgemate® Pro scoring
devices

The Bridgemate is a small device designed to
enhance the enjoyment of bridge for tournament
directors and bridge players alike. The system
enables you to enter scores faster than before, and
is guaranteed to prevent operator errors. As well as
allowing players to enter board results, the
Bridgemate also feeds information to the players,
such as the achieved percentage on the board
played, and the traveler overview. We are convinced
that tournament directors and bridge players will
appreciate the convenience of the Bridgemate!

Preparing the Bridgemate for use

The Bridgemates are individually packed in compact sturdy cardboard boxes. Each Bridgemate comes
complete with four AAA batteries, which must be inserted into the bottom of the Bridgemate unit. The
+ and — signs in the casing indicate the insertion direction of the batteries. Insert all four batteries in
the direction indicated, close the lid and press the OK button. Check whether the text “Bridgemate
Pro” appears. The Bridgemate is now ready for use.

Exploring the Bridgemate
The keyboard

The Bridgemate keyboard contains 25 keys. Some of the keys have a dual function.
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Keys Explanation

These keys are used to enter numbers in the Bridgemate, for
example board numbers, pair numbers, contract and result. The
10 button is used to enter 0 (when entering member numbers,
board numbers etc) and to indicate 10 as the lead card.

1to 9, 10

These keys enable you to indicate the contract type or the card
color of the lead card.

&, ¢, v A NT
+, - Indicates overtricks or downtricks of the result.
= Indicates that the contract has been exactly made.

Use these keys to specify Jack/Queen/King/Ace as the lead

3 QKA card.

X, XX Double or redouble.

N/S, E/W Direction of play indicated by the declarer.
PASS Indicates a pass-out.

CANCEL Correct an entry and cancel commands.
OK Confirm an entry.

Switching on/off

The Bridgemate does not have a separate on/off button. To switch on the Bridgemate, press the OK
button. It is not possible to switch off the Bridgemate manually. The Bridgemate will automatically
switch off after it has been idle for a while, i.e. no buttons have been pressed. No data will be lost
when the Bridgemate switches off. Simply press the OK button to continue as before. In other words,
you can continue entering scores as soon as the Bridgemate has been activated again.

The default autopower-off time is set to 20 seconds. This value can be reset to between 5 and 60
seconds.

Activating the Bridgemate

When switching on the Bridgemate Pro for the first time, you will be taken to the main screen:

BRIDGEMATE PRO
V2.0 EN

(version number and language code may differ)

Press the OK key again to view the section and table settings of the Bridgemate. The default setting is
section A, table 1. If these settings are correct, move the Bridgemate to the corresponding table. The
Bridgemate is now ready for use.

Configuring the section and table

You will need to configure the section and table per Bridgemate. To do this, insert the TD-key in the
Bridgemate when the “Bridgemate Pro” screen is displayed. The following screen will now appear:



Chapter 5: Use of the Bridgemate® Pro scoring devices 23

GROUP: A O +/-
TABLE: 1

Use the + and - key to adjust the section. Section range from A to Z. To switch channels, press 0, 1
and 2. See Chapter 2 for more information on setting the channels of the Bridgemate.

Press OK to confirm the section. The following screen will now be displayed:

GROUP: A O
TABLE: 1_ 0-9

Use the number keys to set the correct table number. Press CANCEL to delete the current number.
Table numbers range from 1 to 511.

Press OK again to confirm the table number. The Bridgemate will display a message informing you
that the settings have been saved. The Bridgemate will retain these settings until you next change the
section and table number. In other words, these settings will be retained even after the session has
been completed. It is therefore not necessary to change the settings for the next session. All you need
to do is move the Bridgemate to the correct table.

To exit the screen, simply remove the TD-key. The Bridgemate will return to the main screen, and no
changes will be made to the section and table number.

Activating the server

For more information on how to activate the server, please see Chapter 3.

Entering scores with the Bridgemate
Who operates the Bridgemate?

As with the score card, the Bridgemate is operated by North. North is also responsible for the correct
operation. East is responsible for verification of the entered board results.

Switching on/off

To switch on the Bridgemate, press the OK button. The Bridgemate will automatically switch off after it
has been idle for a while, i.e. no buttons have been pressed. No data will be lost. Press the OK button
again to continue as before.

Activating the Bridgemate

At the start of the session, the Bridgemate will by default display the “Bridgemate Pro” main screen,
including the version number and language code. Press OK to view the table and section settings of
the Bridgemate. For example:

GROUP: A
TABLE: 1

To activate the Bridgemate and log on to the server, press OK again. The Bridgemate has now been
activated and can be put into use.

Entering member numbers (optional)

If you have specified in BPC that you wish to enter member numbers, the Bridgemate will ask you -
after activation and before the start of the first round - to enter the member numbers of the four
players.
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The number must be numeric and has a maximum of 12 digits. Use the number keys to enter the
number, and confirm by pressing the OK key. If a player does not know his member number or does
not have a member number, press OK without entering a number. No number will be registered for
this player.

Once a member number has been entered for West, the numbers will be fed to the server and the
Bridgemate will start the first round.

Information before the start of the round

At the start of each new round, the Bridgemate will display the new round and the expected pairs, as
well as the direction of play. The boards will also be displayed. For example, you can verify at the start
of the round whether you are seated in the correct direction and have the correct boards on the table.
This information is displayed as follows:

ROUND 1, 1-4
NS: 1 EW: 2

Press OK to confirm this screen and continue with the board input.
Entering board results

The following screen will be displayed when entering the board results:

BOARD: _
CONTR:

The flashing line indicates the input position. Before starting the game, enter the board number and
press OK to confirm. The Bridgemate will verify the number. An error message will be displayed if the
board number does not appear in that round:

BOARD NUMBER
INCORRECT! R1

R1 indicates that the Bridgemate is in round 1. The message will disappear after a few seconds. You
will now be asked to enter the correct board number.

If the board is entered a second time within the same round, the following message will be displayed:

BOARD ALREADY
PLAYED! R1

It is not possible to enter a board twice in the same round. If the board result has been entered
incorrectly and requires correction, delete the board result from the TD menu (see further) and re-
enter the score.

Once the board number has been entered and confirmed, the cursor will jump to the second line. You
can now begin bidding. As soon as the contract has been determined, enter the contract type and the
direction of the declarer.

To enter the contract, use numbers 1 to 7 and the &, ¢, v, a and NT keys. If required, you can also
use the X and XX keys to indicate double or redouble. To specify the declarer, use the N/S and E/W
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keys. If the declarer is North, press N/S once. If the declarer is South, press this key twice. Ditto if the
declarer is East or West. The screen is displayed as follows:

BOARD: 13
CONTR: 3NT X E_

Press OK to confirm this.
Entering lead card (optional)

If you have specified in BPC that lead cards must be entered, the Bridgemate will ask you to confirm
the lead card.

LEAD:
RESULT:

To enter the lead card, select %, ¢, v or a first to indicate the card type. Next, press one of the keys
(210 9,10, J, Q, K or A) to specify the card. Press OK to confirm the lead card.

Entering the result

Once you have finished playing the board, you can enter the result. When the contract has been
exactly made, press the = key. To indicate overtricks, use the + key and enter the number of
overtricks. For downtricks, use the — key.

Verification by east

Once you have entered the contract, the lead card and the result, press OK. The message
"Verification by east" will now be displayed. The Bridgemate must now be passed to East to verify the

entered data.

The verification screen will for example be displayed as follows:

Board 13, 3NTx +1
by East, -950

The board data entered by North is displayed on one total screen (the lead card will not be displayed).
In addition, the number of score points obtained on this board will be displayed. Depending on the
BPC setting, the number of score points will be displayed as assigned to the North/South pair or to the
declarer.

Confirming board result

East verifies the data displayed on the verification screen. If this data is incorrect, East will press
CANCEL to edit the data. If the result is correct, East will press OK to confirm the result. The message
“Entry completed” will now be displayed. The data is saved and sent to the server. It is now no longer
possible for players to edit the results.

Overview of percentage achieved and previous results (optional)

Once East has confirmed the board result, players have a number of feedback options for their
achieved board result. Depending on the BPC settings, the following information can be displayed:

e Achieved percentage for the entered board result
e Overview of score of other pairs on the entered board

If one (or both) of the functions is activated, the message “Entry completed” will also display the text
“Show results?”. Press OK to view information on the achieved board result.
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The percentage achieved on the board will be displayed first. This is done by reviewing the other
scores registered on the board, the value of the entered score and how the entered score compares
with the other scores. This percentage will have little significance at the start of a session. As the
session progresses, the percentage will approximate the actual end percentage on the board.

3NTX E +1
-950 = 33%

The percentage relates to the entered number of score points. Depending on the BPC setting, this
always applies to the North/South pair and/or the declarer. Press OK to exit this screen.

If you have set BPC to also display the scores of other pairs on the entered board, the Bridgemate will
display these results. This screen is displayed as follows:

S 25 = +110
E* 3NTx +1 -950

The scores are sorted from high to low on the basis of the achieved score points of North/South. The
score achieved by the table is displayed with a * (optional). The scores are displayed in pairs. If there
are multiple board results, press OK to view the next results.

It is possible to set BPC to view the scores again after they have all been displayed.
End of round

At the end of the round, the Bridgemate will display the message "End of round". You do not need to
do anything. The Bridgemate will automatically switch off after a few seconds. Press OK again to
begin entering the scores in the next round.

End of session

At the end of the last round, the Bridgemate will display the message “End of session” and return to
the Bridgemate Pro main screen after a few seconds. The Bridgemate has completed its tasks and
can now be safely stored away.

Special entries: pass-out and board not played

If the players have passed four times without offering a contract, enter ‘Pass’ at CONTR and confirm
with OK. You will not be asked for the lead card and the result, and the Bridgemate will switch
immediately to the verification screen.

If a board has not been played in a particular round due e.g. to time constraints, the Bridgemate must
be informed. If this step is skipped, the Bridgemate will remain in the uncompleted round, and other
pairs will be prevented from entering their results. To enter an unplayed board, press the 10 key in the
CONTR screen. The screen will now display the text NP (‘not played’). Confirm by pressing OK. The
Bridgemate will now display the verification screen again.

The Bridgemate will not display an overview for unplayed boards. As it is possible to play the board in
a later round, players must be prevented from seeing the results of previous boards. The board can be
played afterwards without the Bridgemate; in that case, the relevant score must be stored manually in
the scoring program.

Rectifying an input error

If you have made an input error, press CANCEL to rectify the error. In principle, it is possible to return
to the board number input screen by repeatedly pressing this button. It is also possible for East to
reject the entered data by pressing CANCEL. The Bridgemate will now return to the input screen, and
the entered data can be deleted by pressing CANCEL again. Once East has confirmed the score and
the message “Entry completed” has been displayed, the score cannot be edited. This option is only
available to tournament directors.
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Please note:
e ltis not necessary to enter the number of score points (+420, -50 etc.) in the Bridgemate. The
Bridgemate will calculate this using the entered contract and result, taking vulnerability into
account.

e The Bridgemate monitors the active rounds. In case of a sit-out, the Bridgemate will skip this
round.

e Before starting a new round, verify whether you and your opponents are seated in the correct

direction to avoid playing in the wrong direction. At the start of the round, press OK to display
the directions.

Reading Bridgemate Pro scores

Scores to Bridgemate Pro Control

Scores entered on the Bridgemate Pro are first saved on the server. The Bridgemate Pro Control
program periodically reads the scores and stores these in the result file. To start or stop this periodic
reading, click on Session - Retrieve data from server. Alternatively, press F4. At the bottom of the
screen, you can check whether the program is busy retrieving scores or is idle. Read-out is activated
by your scoring program (if the program supports this function).

Reading scores in the scoring program

Once the scores have been saved in the result file, your scoring program can read and process the
scores. For more information, please consult the manual of your scoring program.

TD menu

Tournament directors have far-reaching powers to verify the entered scores. A special TD menu is
available for this purpose. To access this menu, please use the TD-key supplied with the package.

Activating the menu

To activate the TD menu, insert the TD-key in the communication port of the Bridgemate. This
requires the Bridgemate to be switched on and waiting for data to be entered (board, contr, lead, result
input screen). It is for instance not possible to activate the menu if the device is in the verification
screen or is displaying an overview of previous results.

To exit the menu, simply remove the TD-key.

Menu options

Once you have inserted the TD-key, the following screen will appear:

TD-MENU

You now have seven options:
1. To enter an arbitral score, press ‘1’.

2. For an overview of the entered scores, press ‘2'.

3. To delete an entry from the current round, press ‘3.
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4. If you would like to view the corresponding table and section of the Bridgemate and/or the
corresponding round and pairs, press ‘4’ (retrieve status).

5. To retrieve an overview of the board numbers not yet entered, press ‘5’.
6. To reset the Bridgemate, press ‘0.
7. To set the contrast of the screen, press + or -.

Entering an arbitral score

It is possible to specify in the Bridgemate that an arbitral score must be entered for a certain board.
The actual percentage must be entered afterwards in the scoring program. In other words, the
Bridgemate registers the irregularities.

Proceed as follows: enter the board number and confirm with OK. The cursor is positioned at CONTR.
Insert the TD-key in the Bridgemate to activate the TD menu. Press ‘1’ and confirm (OK button)
“Arbitral score?” Remove the TD-key. The following screen will now appear (with possibly another
board number):

BOARD: 14
CONTR: ARB_

Press OK to confirm this, and confirm the verification screen. The Bridgemate has now saved an
arbitral score for this board and will feed this to the scoring program during read-out. You can now
enter the correct percentages for both pairs in the scoring program.

Retrieving overview

To obtain a board overview without reading the data or completing a board input, it is possible to use
the special overview function of the TD menu. To access this overview, insert the TD-key and press
‘2’. You will be asked to enter the corresponding board number. The overview displays the pair
number, direction of play, contract and result. The number of score points is not displayed in this
overview. If the screen returns to the TD menu after the board number has been entered, no scores
will be registered for this board.

Erasing entry in the current round

Tournament directors have the option of erasing entries on boards played in the current round. It is not
possible to erase data from previous rounds. To erase a board input, press ‘3’ and press OK when
prompted to confirm “Erase result?” You will be asked to enter a board number. Enter a board number
and confirm with OK. If that particular board has already been played in the current round, the
message “Board erased” will be displayed to indicate that the entered result has been erased. If the
board has not yet been played, or not played on this table in the current round, the TD menu will be
displayed again after you have pressed OK.

Retrieving current status

If you no longer know to which table and section the Bridgemate relates, you can retrieve this
information in the status part of the TD menu. To do so, insert the TD-key in the Bridgemate and press
‘4’. Press OK when prompted to confirm ‘Status?’ The expected table and section of the Bridgemate
will be displayed first. Press OK again to view the current round of the Bridgemate and the
corresponding pairs at the table. You will also see the boards played in this round.

Overview of missing scores
From the TD menu, it is easy to establish which boards of the round have not yet been entered. Press
‘5’ and OK when prompted to confirm ‘Missing boards?’ The Bridgemate will now display the numbers

of the boards not yet entered in this round.

Resetting the Bridgemate
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The Bridgemate can be reset from the TD menu. It will now return to the main screen. Press 10’ and
OK when prompted to confirm ‘Reset?’.

Setting contrast
It is possible to set the contrast of the screen from the TD menu. Press + to make the screen darker,

— to make the screen lighter. Press the button several times to adjust the contrast. It is also possible to
adjust the contrast if the Bridgemate is in the main screen.
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Chapter 6: Additional Bridgemate functions

Bridgemate Pro Control has a number of functions specifically designed for the Bridgemate scoring
devices.

Reading scores manually in Bridgemate

All entered scores are also saved in the local memory of the Bridgemates. If for whatever reason a
Bridgemate is unable to feed a board result to the server, you have the option of reading the scores
manually in Bridgemate Pro Control at the end of the session. This is done using the menu Session >
Read Bridgemate Locally.

To use this function, it is necessary to connect a Bridgemate communication cable to the serial port of
your PC. This communication cable is available from your Bridgemate supplier.

Read Bridgemate data locally |

Status
Connect Bridgemate. ..

Connect the Bridgemate to the communication cable via the data port at the back of the Bridgemate.
All board results are read and stored in the result file score, including scores that have already been
sent. These scores can now be processed in your scoring program in the usual way.

Bridgemate settings

All Bridgemate settings can be changed via the menu Tools > Options - Bridgemate tab.

General
—Resultz — Interval settings
IV Show previous results Autopower-off penod; W zeconds

¥ Shaw avin result
[ Bepeat results

b aximum results to show: IUnIimited 'I

¥ Show percentage of own result

Yenfication message: |2 'l seconds

— Cantract

Show contracts using:

¥ Group sections for results " Symbols
{+ Characters
— Scare points
Show score points from perspective of: — Optional entry
" Marth - south ™ Lead card
&+ Declarer [ Member numbers

Changes to Bridgemate settings will only be applied
when the table iz newly added to the server.

Cancel | Ok, I
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Displaying previous results

To enable the Bridgemate to display an overview of previous board results of a particular game, check
the “Show previous results” option. If you would also like to display your own score, check the “Show
own result” option. Own scores are indicated by a *. To offer the players the possibility of viewing the
results more than once, check the “Repeat results” option. To limit the number of results shown on the
Bridgemate, set the maximum results to any number between 1 and 127. To remove the limitation, set
the maximum to unlimited.

The Bridgemate Pro system calculates for every score what percentage will be awarded to the entered
result. To show this percentage on the Bridgemate, check the option “Show percentage of own result”.

When multiple sections are calculated as one, you should check the option “Group sections for
results”. The percentage will be calculated through all sections, and the results on all boards with the
same number are shown in the overview of previous results. Particularly in this case, it is
recommended to set a maximum number of scores you want the Bridgemate to show. Without doing
so, the players will use up a greater amount of time watching the results at large sessions.
Displaying score points

The score points can be displayed from the perspective of the player declaring the game or from the
North/South direction of play. In the latter case, score points are obtained by displaying East-West as
an opposite score (4H+1 by East-West is displayed as -450 of -650). This applies both to the score
points displayed in the verification screen for East and to the “previous board results” overview screen.
View contract

Use this function to specify whether the Bridgemate uses card symbols or letters for the contracts.

Autopower-off periods

The Bridgemate will automatically go into autopower-off mode if it remains idle for a while. The default
setting is 20 seconds. To change this setting, enter a value between 5 and 60 seconds in “Autopower-
off period”. In “Verification message”, enter the length of time you would like the message “Verification
by East” to be displayed on the screen.

Note

Changes to Bridgemate settings will only be applied when the table is newly added to the server and
the Bridgemate is logging in.

System functions

The Bridgemate has two separate system functions. In both cases, the communication cable must be
connected to the PC.

Changing Firmware
The Bridgemate is controlled by a piece of software in the internal memory. This software can be
changed from BPC. In concrete terms, this means that the Bridgemate can be updated and that new
functions can be added. The language selection option for example can also be changed. In other
words, the Bridgemate can be updated without requiring you to purchase new Bridgemates.
To update the Bridgemate firmware, proceed as follows:

1. Go to Tools > Bridgemate > Update firmware.

2. Press Choose firmware file.
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3. Select a Bridgemate firmware file to be loaded into the Bridgemate. These files have the
extension ‘.bpf. Once the file has been selected, the location, version number and date of the
file are displayed.

4. Switch on the Bridgemate and connect it to the PC. If the Bridgemate is not switched on,
connect it first and press OK.

5. The program is written in Bridgemate. Wait with disconnecting the Bridgemate until the text
"Writing firmware completed. Disconnect Bridgemate" is displayed.

6. The new program has now been loaded. Press OK to activate the Bridgemate.

The process will be cancelled if an error occurs during loading. Disconnect the Bridgemate and
reconnect to repeat the process. If the problem persists, replace the batteries of the Bridgemate.

WARNING

Only use this option on the instructions of the supplier. Incorrect use may result in faulty operation.
Only use those files supplied by your supplier and follow the instructions carefully. We strongly advise
against any other use.

Bridgemate analysis

The Tools = Bridgemate - Bridgemate analysis menu contains relevant information on the
Bridgemate, including version numbers, set autopower-off time and/or correct operation of the
Bridgemate.
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Multiple connections in one room

There may be times when you wish to enable multiple use of one table number, for example when
inviting other bridge clubs to play. As the Bridgemate Pro server can only incorporate one table at a
time, it is not possible for two clubs to make use of one server simultaneously. Both bridge clubs will
therefore require their own server. It is of course vitally important that they do not interfere with each
other. This problem can be rectified by getting the systems to communicate over different channels.
The first club sets its system (server and Bridgemates) to channel 0, while the other uses channel 1. A
third club can then use channel 2. This method enables a maximum of three clubs to use the
Bridgemate Pro scoring system simultaneously without causing any interference.

Big tournaments

During big tournaments, more than one server will be required to control over 128 tables. The layout of
the tables is important in this respect. If the tables are outside the range of the server, an extra server
will be needed to increase the range. The Bridgemate Pro scoring system supports multiple servers
over a network. In principle, this network can support an unlimited number of tables. The following
guidelines must be observed:

- You will need a fully operational network in which all used PCs are interconnected, enabling
them to access and process files.

- Only one result file is used, containing all session data and board results of all tables.

- ltis not necessary for one of the client PCs to contain the scoring program and/or the result
file. From an organizational point of view, it would be handier to use a separate PC containing
the scoring program and result file. Clients access the result file over the network.

- Each server is connected to its own PC (=client). Do not connect two servers to one client.
Although technically feasible, it may cause unnecessary confusion, as both servers are using
the same client name. Worse still, it may even be counter-productive if both servers are
operating over the same channel.

- Use different channels for the servers, especially if you are operating a maximum of three
servers or if the servers are interfering with each other.

- Only use the same channels if you are operating more than three servers and the servers are
not interfering with each other (e.g. in different buildings).

Note

An extended version is available offering more than three channels. Please contact your distributor for
more information.
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English

Hereby, Bridge Systems BV, declares that this Bridgemate® Pro Wireless Scoring System is in
compliance with the essential requirements and other relevant provisions of Directive 1999/5/EC.

Finnish

Bridge Systems BV vakuuttaa taten ettd Bridgemate® Pro Wireless Scoring System tyyppinen laite
on direktiivin 1999/5/EY oleellisten vaatimusten ja sité koskevien direktiivin muiden ehtojen mukainen.

Dutch

Hierbij verklaart Bridge Systems BV dat het toestel Bridgemate® Pro Wireless Scoring System in
overeenstemming is met de essenti€le eisen en de andere relevante bepalingen van richtlijn 1999/5/EG.

French

Par la présente Bridge Systems BV déclare que l'appareil Bridgemate® Pro Wireless Scoring
System est conforme aux exigences essentielles et aux autres dispositions pertinentes de la directive
1999/5/CE.

Swedish

Harmed intygar Bridge Systems BV att denna Bridgemate® Pro Wireless Scoring System star |
Overensstammelse med de vasentliga egenskapskrav och 6vriga relevanta bestémmelser som framgar
av direktiv 1999/5/EG.

Danish

Undertegnede Bridge Systems BV erkleerer herved, at folgende udstyr Bridgemate® Pro Wireless
Scoring System overholder de vaesentlige krav og gvrige relevante krav i direktiv 1999/5/EF.

German

Hiermit erklart Bridge Systems BV, dass sich dieses Bridgemate® Pro Wireless Scoring System in
Ubereinstimmung mit den grundlegenden Anforderungen und den anderen relevanten Vorschriften der
Richtlinie 1999/5/EG befindet. (BMWi)

Greek

ME THN lNAPOYZ2A Bridge Systems BV AHAQNEI OTI Bridgemate® Pro Wireless Scoring System
SYMMOP®QONETAI MIPOS TIZ OYZIQAEIZ ATMAITHZEIS KAI TIZ AOITIEZ 3XETIKEZ AIATAZEIS> THZ
OAHIIAZ 1999/5/EK.

Italian

Con la presente Bridge Systems BV dichiara che questo Bridgemate® Pro Wireless Scoring System
€ conforme ai requisiti essenziali ed alle altre disposizioni pertinenti stabilite dalla direttiva 1999/5/CE.

Spanish

Por medio de la presente Bridge Systems BV declara que el Bridgemate® Pro Wireless Scoring
System cumple con los requisitos esenciales y cualesquiera otras disposiciones aplicables o exigibles
de la Directiva 1999/5/CE.

Portuguese

Bridge Systems BV declara que este Bridgemate® Pro Wireless Scoring System esta conforme
com os requisitos essenciais e outras disposi¢des da Directiva 1999/5/CE.

Malti

Hawnhekk, Bridge Systems BV, jiddikjara li dan Bridgemate® Pro Wireless Scoring System
jikkonforma mal-htigijiet essenzjali u ma provvedimenti ohrajn relevanti li hemm fid-Dirrettiva 1999/5/EC.

Estonian

Kéesolevaga kinnitab Bridge Systems BV seadme Bridgemate® Pro Wireless Scoring System
vastavust direktiivi 1999/5/EU pdhinduetele ja nimetatud direktiivist tulenevatele teistele asjakohastele
satetele.

Hungarian

Alulirott, Bridge Systems BV nyilatkozom, hogy a Bridgemate® Pro Wireless Scoring System
megfelel a vonatkozo alapvetd kdvetelményeknek és az 1999/5/EC iranyelv egyéb eldirasainak.

Slovak

Bridge Systems BV tymto vyhlasuje, Ze Bridgemate® Pro Wireless Scoring System spifia zakladné
poziadavky a vSetky prisluSné ustanovenia Smernice 1999/5/ES.

Czech

Bridge Systems BV timto prohlasuje, Ze tento Bridgemate® Pro Wireless Scoring System je ve
shodé se zakladnimi pozadavky a dal$imi pfisluSnymi ustanovenimi smérnice 1999/5/ES.

Slovene

Siuo Bridge Systems BV deklaruoja, kad $is Bridgemate® Pro Wireless Scoring System atitinka
esminius reikalavimus ir kitas 1999/5/EB Direktyvos nuostatas.

Lithuanian

Siuo Bridge Systems BV deklaruoja, kad &is Bridgemate® Pro Wireless Scoring System atitinka
esminius reikalavimus ir kitas 1999/5/EB Direktyvos nuostatas.

Latvian

Ar So Bridge Systems BV deklaré, ka Bridgemate® Pro Wireless Scoring System atbilst Direktivas
1999/5/EK bitiskajam prasibam un citiem ar to saistitajiem noteikumiem.




